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Protect user names and passwords at all times.

Login is not required to download a BAA or access help.

Account integrity is critical to BIDS and the soliciation process. 
E-mail is the only method of communication between the 
Government Contracting Officer and submitters. Be sure to 
maintain the information in your BIDS registration.

Use the RSS (Really Simple Syndication) news feed to 
automatically receive BIDS notices. See Online Help for 
set up instructions.

Examples and templates are available online.

Submissions uploaded to BIDS are secure 
from public access. All data is considered 
source selection sensitive and protected 
accordlingly. Submissions are reviewed by 
the user and authorized evaluators only.

NEWNEW

Submitters can now add to or change the Comment field in 
their registration at any time.
All information contained in emails, related to follow on 
submissions (if one is requested), is now saved as part of the 
submission record.

Internet Explorer version 6.0 
or higher is recommended.

BIDS also supports Firefox 
3.0 or later.

Browser settings must be configured to allow pop-ups for 
BIDS to work properly. In addition, disable any third party 
pop-up blockers.

View or Download a BAA
From the Homepage:

• Click Download BAAs.

• Right click to save file locally.

•  Select Save Target As.

• Name the file and click Save.

Accounts and Password Information

Passwords

Forgot My Password
Registered users with a valid e-mail address can automatically reset a 
password.

From the Homepage:

• Select Forgot My Password.

• Enter required information.

• Click Submit.

•  Change the account password especially when changes to 
personnel occur.

•  Passwords should be at least six digits. Include alphanumeric 
combinations of upper and lower case letters and special characters.

New Accounts and Reregistering
The BIDS registration POC should reflect the submitter’s contract 
authority.

•  Register if you are a new user to BIDS and a submitter account 
does nOT exist.

•  Reregister if a POC is no longer valid and no submission 
evaluations are pending.

Do not reregister if a valid account exists and submissions are 
pending evaluation.

General BIDS Help
Help links are available to all users in any BIDS view. 

• Online Help - provides instruction on topics related to BIDS use.

• FAQs - lists frequently asked questions and answers about BAAs.

• Help Request - submits an e-mail to the BIDS Help Desk.

•  Submitter QuickCard - download a PDF version of the QuickCard 
from the BIDS Homepage.

Homepage
The Homepage offers several areas of interest to submitters. Check the 
BIDS Advisory and Announcements section for information about BAAs 
and other news items.

Web Browser Settings

From the BIDS Homepage:

•  Under Downloads, click Reference Materials.

•   Under Document Format, right click the document of choice.

•  Save the file locally.

Help with Submissions
Be sure to follow the guidance provided in the BAA when creating 
submissions.  

Doing Business with the Government 
This section provides links to other Government sites that will help 
submitters prepare for contract award.

Contact the Help Desk for POC changes during an active BAA. Be 
prepared to verify company identity, account information, and the reason 
for the change.



Evaluation Criteria and Other BAA Information

Registration and Other User Information

Submitter registration is automatic and will be acknowledged by 
e-mail. Be patient this takes several seconds to be recognized 
by BIDS. 
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All submissions must follow the instructions in the published BAA 
package. Include all specified information to avoid disqualification 
or delays in evaluation. Always refer to the published BAA package 
for the most up-to-date guidance.

User Names must be unique to the database and contain no 
special characters or spaces. POC information should reflect the 
business or contracting authority for the agency or company.

Submitting a Registration
A registration is required to respond to a BAA.

From the Homepage:

• In the Login panel, click Register.

•  Select Submitter as the registration type.

•  The registration form is typical to e-applications. Complete all 
mandatory fields (marked *). 

•  BIDS registration business information is used for statistical data 
collection only. To ensure accurate analysis and consideration in 
special business programs, current information is requested. 

• Click Submit; make sure the Success Message displays.

Updating Contact Information
• From My Account, select Edit My Account.

• Verify and edit contact information as required.

• Click Submit.

Login
From the Homepage:

• Enter User name.

• Enter Password.

• Click Login.

Change Password
• From My Account, select Change My Password.

• In the Old Password field, enter current password.

•  In the new Password field, enter a new password.

•  In the Confirm Password field, re-enter the new password.

• Click Submit; ensure the Success Message displays.

Changing the password will terminate the BIDS session and you will 
need to login using the new password.

Evaluation Criteria
Submissions are evaluated according to individual merit and 
relevance to the program requirement rather than against other 
proposals. Evaluation criteria highlights from the BAA package are:

Basic Requirement:
• Proposed solution meets the stated requirement.
•  Proposal exhibits comprehensive understanding of the problem  

and the requirements of intended users.
• Multiple users (U.S. Government or commercial).

Cost:
• Achievable, reasonable, and complete for work proposed.
• Costs analyzed and risks addressed.

Schedule:
• Achievable and reasonable for proposed solution.
• Risk and critical elements addressed.

Technical Performance:
• Approach is feasible, achievable, and complete.
• Technical team has expertise and experience.
• Effort defined, complete, and in logical sequence.
•  Deliverables and products clearly defined and will meet the 

requirement.
• Technical risks and mitigation defined, feasible, and reasonable.
• Government Furnished Equipment and materials are identified 

with need dates.
• Intellectual property ownership addressed.
• Transition to production addressed.
• Other agency interest or funding is documented.

Past Performance:
• Success in similar efforts.
• Demonstrated ability to deliver products within budget and 

schedule.
•  Team has demonstrated expertise in the technical area proposed, 

and in cost, schedule, and risk management.

Mandatory BAA Closing Date and Time
Every BAA will specify a closing date and time. Times are always in the 
current Eastern Time zone. Submissions will not be accepted after closing.

Be sure to register, login, and upload submissions early.



Phase I Document Preparation
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 Submitting to a BAA Requirement

Use the sample Quad Chart as guidance. Refer to the BAA 
package for all content requirements. Quad Charts do not 
require a cover page.

Submitter Tools are accessible only after login.

Shot-gunning or uploading a submission to every requirement is 
not good practice and is strongly discouraged.

Select the appropriate radio 
button to provide the response.

Uploading a Submission
Before you begin, review Tips and Hints for Success (see back page). 
Know the location of the file to upload. Check the file name and file size.

• Login to BIDS.

• Under Submitters Tools, select Respond to BAA.

• Under Show BAA#, select the BAA of interest.

• Click the requirement number.

• Review the checklist, click OK to continue.

•  Complete the required fields in the submission record. 

• Use Browse to select a file.

• Click Submit for Processing.

• Wait for the Success Message to display.

• To verify proper file upload, click the file attachment link.

Modifying a Submission
Make all edits or corrections to the document on the local computer.

•  Login to BIDS, select My Submissions.

•  Under Show BAA#, select the BAA of interest.

•  Under Status, select Pending Evaluation.

•  Select the document identifier to open the record.

•  Click Edit Submission.

•  Use Browse to select the updated file.

•  Select the checkbox to remove the previous file.

•  Click Submit for Processing.

•  Open the accepted submission record to view next submission due 
date and time.

Checking Submission Progress
• Login to BIDS, select My Submissions.

• Under Show BAA#, select the BAA of interest.

•  Click appropriate status - All Submissions, Pending Evaluation, 
Accepted, or Rejected.

Removing a Submission from Consideration
Submissions can only be removed from consideration before the BAA 
closing date or before the follow-on submission due date.

• Login to BIDS, select My Submissions.

• Under Show BAA#, select the BAA of interest.

• Under Status, select Pending Evaluation.

• Select the submission.

• Click Delete Submission.

• Click Submit for Processing.

Uploading a Follow-On Submission
For each follow-on phase, submitters are prompted at first login to 
update/validate registration information.

• Login to BIDS, select My Submissions.

• Under Show BAA#, select the BAA of interest.

• Under Status, select Accepted.

• Click the appropriate submission to open the record.

• Click Create next Submission.

• Review the checklist and click OK to continue.

• Complete the required fields.

• Use Browse to select the file.

• Click Submit for Processing.

No Bid Guidance
When a follow-on submission is not planned for upload by the submitter, 
a notice in BIDS is required. Provide a letter (attachment) as the next 
submission upload indicating the submission has been revoked from 
further consideration.

Quad Charts
Quad charts are a single page, divided into four quadrants and provide 
the essence of the proposed solution for a specific requirement. 

From the Homepage:

• Under Downloads, select Reference Materials.

•  Under Document Format, select either Quad Chart Sample.

Changes to uploaded responses will be permitted up to the closing 
date and time. Changes after the due date are not permitted.



For Assistance, Contact the BIDS Helpdesk: E-mail: administrator@tswg.netFebruary 2009

Merely editing the file name in the Attachment field on the 
submission form will result in a submission record with no file 
attachment.

      Use the BIDS Logout feature when the session is complete. 
Logout terminates communications with the BIDS server and 
helps to ensure the overall integrity of the BIDS database by 
preventing inadvertent access from an open user session.

never enter or attach classified data in BIDS. Refer to the 
published BAA package for classified data handling.

Apple/ MacIntosh users must have the entire file name and path 
free of special characters and spaces.

These instructions do not apply to Vista compatible applications.

Tips and Hints for Success

Document Identifier
Each submission must contain the document identifier for that 
submission in the header.

The format is: XX-REQTnO-USERnAME-SIT#

•   XX – Subgroup or Mission Area.

•   REQTnO – Requirement Number.

•  USERnAME – BIDS User Name / Submitter Login Name.

•   SIT# - Submitter Internal Tracking Number.

The prefix (underlined in the format above) is based on the selected BAA 
mission area, requirement, and submitter’s user name. The SIT number 
will be entered by the submitter when the submission is uploaded. SIT 
numbers must be unique and must contain only alphanumeric characters, 
hypens, and underscores.

Tips to Reduce File Size
Adobe Acrobat 

•  From the File menu, select Reduce File Size.

•  Select Acrobat Version Compatibility and click OK. Setting 
compatibility to later versions of Acrobat will allow greater reduction 
in file size.

• Select a location, enter a file name, then click Save.

Microsoft PowerPoint

• Select a graphic image in the file. 

• Right click the image, select Format Picture. 

• In the flyout, select Compress.

• In the Compress Pictures frame, select All pictures in Document.

• Click OK.

Graphical Images

• Crop unnecessary borders or unused space.

• Resave the image to a JPEG, GIF, or other compressed format.

Use image formats that are already reduced in size (such as JPEG 
or GIF); however, resolution must be clear to print and view the final 
document onscreen.

Classified documents MUST be received by the applicable due date and 
time. Classification does not eliminate the requirement to comply with all 
BAA instructions.

Format and File Size Limits
Document format is specified in the BAA package. The most common file 
formats are Microsoft Word, Microsoft PowerPoint, Microsoft Excel, and 
Adobe Acrobat (PDF). Any single uploaded file is limited to 500kb (512000 
bytes). Help on reducing overall file size can be found in Online Help.

Suggested SIT Number Formats

Public Access — Up-Loading Options 
Up-Loading a submission from computers such as those found in public 
libraries or businesses is permissible. Keep the following security 
guidelines in mind:

• Store attachments on an external media (CD-ROM or Flash drive). 

• Do not save any information on the local computer.

•  Keep all login information private. 

•  Do not let the computer “remember” the login name and password.

•  When finished be sure to clear the browser history and cache.

Clearing the Computer Cache
Internet Explorer 

• From the Tools menu, select Internet Options.

•  Under General, Temporary Internet Files, select Delete Cookies, 
click OK to perform action. Select Delete Files, include Delete all 
offline content. Click OK to perform action.

•  Under General, History, select Clear History. Click OK to  
perform action. 

•  Click OK to return. 

Firefox 3.0 or higher 

•  From the Tools menu, select Options.

•  Click the Privacy icon.

•  In Private Data, click Clear now.

•  In the Clear Private Data window, check the Cache box and click 
Clear Private Data now.

Restrictive Marking on Proposals
Clearly indicate content disclosure limitations on all submissions. 
Markings can appear as “Proprietary” or words to that effect; however, 
do not use “Company Confidential” or other phrases that could be 
confused with national security classifications.

Procedures for Classified Submittals
First, the submitter must create a placeholder record in BIDS. Attach only 
the cover page. Indicate in the Comments field that the document cannot 
be uploaded to BIDS due to classification.

Next, the submission must be marked, packaged, and mailed in 
accordance with handling requirements for the level of classification. 
Include the BIDS document identifier in the header of the mailed 
document. Refer to the BAA package for more information regarding 
classified submittals. 

File Naming
File attachment names should consist of alphanumeric characters, 
hyphens, and underscores only; special characters are not allowed. 
Correct file names before beginning the upload process.

Submission Type Suggested naming Conventions

Quad Charts
White Papers
Full Proposals

####-QC, ####-QC2, ... QC01, QC02, ...
####-WP, ####-WP2, ...
####-FP, ####-FP2, ...

WP01, WP02, ...
FP01, FP02, ...


